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Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves the
right to make changes and corrections to the information in this
document without the obligation to notify any person or organization of
such changes.

Documentation disclaimer

“Documentation” means information published by Avaya in varying
mediums which may include product information, operating instructions
and performance specifications that Avaya generally makes available
to users of its products. Documentation does not include marketing
materials. Avaya shall not be responsible for any modifications,
additions, or deletions to the original published version of
documentation unless such modifications, additions, or deletions were
performed by Avaya. End User agrees to indemnify and hold harmless
Avaya, Avaya's agents, servants and employees against all claims,
lawsuits, demands and judgments arising out of, or in connection with,
subsequent modifications, additions or deletions to this documentation,
to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not necessarily
endorse the products, services, or information described or offered
within them. Avaya does not guarantee that these links will work all the
time and has no control over the availability of the linked pages.

Warranty

Avaya provides a limited warranty on its hardware and Software
(“Product(s)”). Refer to your sales agreement to establish the terms of
the limited warranty. In addition, Avaya’s standard warranty language,
as well as information regarding support for this Product while under
warranty is available to Avaya customers and other parties through the
Avaya Support website: http://support.avaya.com. Please note that if
you acquired the Product(s) from an authorized Avaya reseller outside
of the United States and Canada, the warranty is provided to you by
said Avaya reseller and not by Avaya. “Software” means computer
programs in object code, provided by Avaya or an Avaya Channel
Partner, whether as stand-alone products or pre-installed on hardware
products, and any upgrades, updates, bug fixes, or modified versions.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AUTHORIZED AVAYA RESELLER
(AS APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AUTHORIZED AVAYA RESELLER. UNLESS
OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES
NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS OBTAINED
FROM ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR
AN AVAYA AUTHORIZED RESELLER; AVAYA RESERVES THE
RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND ANYONE
ELSE USING OR SELLING THE SOFTWARE WITHOUT A LICENSE.
BY INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR
AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF
YOURSELF AND THE ENTITY FOR WHOM YOU ARE INSTALLING,
DOWNLOADING OR USING THE SOFTWARE (HEREINAFTER
REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”),
AGREE TO THESE TERMS AND CONDITIONS AND CREATE A
BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Copyright

Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, or hardware
provided by Avaya. All content on this site, the documentation and the
Product provided by Avaya including the selection, arrangement and
design of the content is owned either by Avaya or its licensors and is
protected by copyright and other intellectual property laws including the
sui generis rights relating to the protection of databases. You may not
modify, copy, reproduce, republish, upload, post, transmit or distribute
in any way any content, in whole or in part, including any code and
software unless expressly authorized by Avaya. Unauthorized
reproduction, transmission, dissemination, storage, and or use without
the express written consent of Avaya can be a criminal, as well as a
civil offense under the applicable law.

Third Party Components

“Third Party Components” mean certain software programs or portions
thereof included in the Software that may contain software (including
open source software) distributed under third party agreements (“Third
Party Components”), which contain terms regarding the rights to use
certain portions of the Software (“Third Party Terms”). Information
regarding distributed Linux OS source code (for those Products that
have distributed Linux OS source code) and identifying the copyright
holders of the Third Party Components and the Third Party Terms that
apply is available in the Documentation or on Avaya’s website at: http://
support.avaya.com/Copyright. You agree to the Third Party Terms for
any such Third Party Components.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation and Product(s) provided by Avaya are the
registered or unregistered Marks of Avaya, its affiliates, or other third
parties. Users are not permitted to use such Marks without prior written
consent from Avaya or such third party which may own the Mark.
Nothing contained in this site, the Documentation and Product(s)
should be construed as granting, by implication, estoppel, or otherwise,
any license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com.

Contact Avaya Support

See the Avaya Support website: http://support.avaya.com for product
notices and articles, or to report a problem with your Avaya product.
For a list of support telephone numbers and contact addresses, go to
the Avaya Support website: http://support.avaya.com, scroll to the
bottom of the page, and select Contact Avaya Support.

2     Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013
Comments? infodev@avaya.com

http://support.avaya.com/
http://www.avaya.com/support/LicenseInfo
http://support.avaya.com/Copyright
http://support.avaya.com/Copyright
http://support.avaya.com
http://support.avaya.com
http://support.avaya.com
mailto:infodev@avaya.com?subject=Avaya CallPilot® Desktop Messaging User Guide for My CallPilot


Contents

Chapter 1: Customer service............................................................................................. 7
Getting technical documentation............................................................................................................... 7
Getting product training............................................................................................................................. 7
Getting help from a distributor or reseller.................................................................................................. 7
Getting technical support from the Avaya Web site.................................................................................. 8

Chapter 2: Using My CallPilot............................................................................................ 9
Getting started........................................................................................................................................... 10
About this guide........................................................................................................................................ 10
Hardware and software requirements....................................................................................................... 10
Windows-based hardware and software................................................................................................... 10
Macintosh-based hardware and software................................................................................................. 11
Linux-based software................................................................................................................................ 11
Peripheral hardware and software (including audio player)...................................................................... 12
Requirements for the embedded CallPilot Player..................................................................................... 12
Logging on................................................................................................................................................ 13
To log on to My CallPilot........................................................................................................................... 14
Logging on to environments with multiple CallPilot servers...................................................................... 14
To configure or update the settings to connect to My CallPilot................................................................. 15
To change to another server..................................................................................................................... 15
To change to another language................................................................................................................ 16
To log on using secure login..................................................................................................................... 16
To log on remotely.................................................................................................................................... 16
To log out.................................................................................................................................................. 16
To download audio players....................................................................................................................... 16
Accessing your CallPilot messages.......................................................................................................... 17
To check for new messages..................................................................................................................... 17
To open a message.................................................................................................................................. 18
To select a message................................................................................................................................. 18
To delete a message................................................................................................................................. 18
To select your telephone or computer to play and record voice messages.............................................. 18
Changing your message sort order........................................................................................................... 19
Playing voice messages............................................................................................................................ 20
To play a voice message the quick way (Windows only).......................................................................... 21
To play a voice message in a mixed voice, fax, or text message............................................................. 22
Viewing fax messages.............................................................................................................................. 22
To view a fax message............................................................................................................................. 22
Composing voice messages..................................................................................................................... 23
To record and send a new voice message using the embedded CallPilot Player.................................... 23
To record and save a message using the stand-alone CallPilot Player.................................................... 25
Composing fax and text messages........................................................................................................... 26
To create and save a fax file..................................................................................................................... 26
To compose and send a fax or text message........................................................................................... 27
Calling the sender of a message.............................................................................................................. 28
To call the sender of a message............................................................................................................... 29

Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013     3



Forwarding and replying to messages...................................................................................................... 29
To forward or reply to a message............................................................................................................. 29
Adding attachments to messages............................................................................................................. 30
To attach a file to a message.................................................................................................................... 30
Setting message options........................................................................................................................... 31
To set message options............................................................................................................................ 31
Addressing messages............................................................................................................................... 31
Accessing CallPilot addresses from other networked CallPilot servers.................................................... 32
To address a message from the CallPilot Address Book.......................................................................... 32
To address a message in Special Addresses........................................................................................... 33
Using the Message Waiting Indicator....................................................................................................... 34
To download and install the Message Waiting Indicator........................................................................... 35
To configure the Message Waiting Indicator............................................................................................. 35
To use the Message Waiting Indicator...................................................................................................... 37
CallPilot Features tab................................................................................................................................ 38
Working with greetings.............................................................................................................................. 38
To access greetings.................................................................................................................................. 38
To record or change a greeting using your telephone.............................................................................. 39
Importing a greeting recorded with a stand-alone audio device............................................................... 39
To delete greetings................................................................................................................................... 40
Setting up message notification................................................................................................................ 40
To access message notification options................................................................................................... 41
Setting up message forwarding................................................................................................................ 43
To set up message forwarding.................................................................................................................. 43
To enable or disable message forwarding................................................................................................ 45
Managing personal distribution lists.......................................................................................................... 45
To edit, delete, or create personal distribution lists................................................................................... 46
Changing your CallPilot password............................................................................................................ 46
Password change service......................................................................................................................... 47
Changing your telephone options............................................................................................................. 48
To access your telephone options............................................................................................................ 48
To assign a custom operator number for callers....................................................................................... 48
To set times and options for blocking messages from callers.................................................................. 49
To turn Auto Login on or off...................................................................................................................... 49
To hide your name and number in CallPilot Address Books..................................................................... 50
To select which directory numbers are associated to your Message Waiting Indicator............................ 50
Setting up telephone access to e-mail...................................................................................................... 50
To set up an e-mail account for telephone access................................................................................... 51
Changing fax printing options................................................................................................................... 51
To access fax printing options................................................................................................................... 52
To change the default printer.................................................................................................................... 52
To turn Auto printing on or off................................................................................................................... 52
To turn first page printing only on or off.................................................................................................... 52
To turn fax separator page printing on or off............................................................................................. 52
Setting up links to your e-mail accounts................................................................................................... 53
To set up a link to your e-mail account..................................................................................................... 53
Searching external e-mail address books (LDAP databases).................................................................. 55

4     Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013



Using your linked e-mail accounts............................................................................................................ 56
To open a message.................................................................................................................................. 56
To delete a message................................................................................................................................. 56
To compose and send a new message.................................................................................................... 56
To forward and reply to messages............................................................................................................ 56
Setting messaging preferences................................................................................................................ 57
To access messaging preferences........................................................................................................... 57
To change message list columns.............................................................................................................. 57
To add a signature.................................................................................................................................... 58
To change environment settings............................................................................................................... 58
Choosing a home page for My CallPilot.................................................................................................... 58
Useful Information tab............................................................................................................................... 59
Transcribing voice forms........................................................................................................................... 61
Protecting the security of your mailbox..................................................................................................... 61

Remote Text Notification for Microsoft Outlook and BlackBerry Devices.................... 63
Notification message format...................................................................................................................... 64
Getting started with remote text notification.............................................................................................. 64
Requirements............................................................................................................................................ 64
Configuration steps................................................................................................................................... 65
Creating a notification holding folder......................................................................................................... 65
To create a notification folder.................................................................................................................... 65
To route notification messages to the holding folder................................................................................ 66
Configuring BlackBerry Desktop Manager................................................................................................ 68
To configure e-mail redirection.................................................................................................................. 68
Automatically removing notification messages......................................................................................... 69
To set up deletion of notification messages.............................................................................................. 70
To activate AutoArchive............................................................................................................................ 71

Index..................................................................................................................................... 73

Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013     5



6     Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013



Chapter 1: Customer service

Visit the Avaya Web site to access the complete range of services and support that Avaya provides. Go
to www.avaya.com or go to one of the pages listed in the following sections.

Navigation

• Getting technical documentation on page 7
• Getting product training on page 7
• Getting help from a distributor or reseller on page 7
• Getting technical support from the Avaya Web site on page 8

Getting technical documentation
To download and print selected technical publications and release notes directly from the
Internet, go to www.avaya.com/support.

Getting product training
Ongoing product training is available. For more information or to register, you can access the
Web site at www.avaya.com/support. From this Web site, you can locate the Training contacts
link on the left-hand navigation pane.

Getting help from a distributor or reseller
If you purchased a service contract for your Avaya product from a distributor or authorized
reseller, contact the technical support staff for that distributor or reseller for assistance.
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Getting technical support from the Avaya Web site
The easiest and most effective way to get technical support for Avaya products is from the
Avaya Technical Support Web site at www.avaya.com/support.

Customer service
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Chapter 2: Using My CallPilot

My CallPilot from Avaya is a Web-based messaging system that offers exceptional flexibility for managing
your messaging needs.

You can work with My CallPilot from any computer that has network access and a Web browser configured
for My CallPilot. Here are some of the many ways you can use My CallPilot:

• Record, edit, and delete greetings that callers hear when they reach your mailbox.

• Receive, forward, reply to, and send voice messages, faxes, and e-mails.

• Address messages to Avaya CallPilot® users on local and remote servers, as well as to non-Avaya
CallPilot users.

• Set up message forwarding to another CallPilot mailbox or to an external e-mail address.

• Configure e-mail-by-phone.

• Set up links to your e-mail.

• Change your CallPilot mailbox password.

• Create personal distribution lists.

• Set up remote notification to a telephone or pager.

• Set up text message notification for a wireless e-mail device. See Chapter 3 for details.

• Transcribe voice forms, if your site uses voice forms to collect information.

Your mailbox must have desktop messaging capability enabled in order for you to access CallPilot voice
or fax messages using My CallPilot. Some features mentioned in this guide are optional. For details, refer
to the Feature availability topic in the CallPilot Player online Help, or ask your administrator.

 Note:
The screen images of dialog boxes shown in this guide are those displayed when operating My CallPilot
in the Windows environment, unless otherwise specified. Users of the Macintosh or Linux environments
might see altered versions of these dialog boxes, depending on specific feature and functionality
support.
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Getting started

About this guide
This user guide describes how to use the Web-based resources of My CallPilot. The
instructions and screen images shown in this guide provide general information for using My
CallPilot through a Web client. Specific details can vary, depending on your computer operating
system and the features available for your CallPilot mailbox.

Hardware and software requirements
You can access My CallPilot from any computer with network access and a Web browser
configured for My CallPilot. Before you start to use My CallPilot, ensure that the computer you
are using is set up according to the following requirements.

 Note:
Support for additional hardware and software may be added in the future as it becomes
available (for example, new browser releases). For more information, contact your CallPilot
administrator.

Windows-based hardware and software
• Operating systems: Windows 2000 Professional, Windows XP Professional, Windows

Vista, Windows 7, or Windows 8

• Windows Browsers: Internet Explorer 6.0, 7.0, 8.0, 9.0, and 10.0; Firefox 2.0 to Firefox
12..0 and Chrome 18.0

• Macintosh Browsers: Safari 5.1.1, Firefox 12.0, Chrome 18.0

• TCP/IP network connection of at least 56 Kbit/s

• Sound card and speakers for playing voice messages on your computer

• A microphone connected to your computer, or a telephone situated near your computer,
for recording voice messages

Using My CallPilot
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 Note:

Turn on Compatibility View for My CallPilot to display pages correctly in Internet Explorer
9.0. To turn on compatibility view:

a. Open Internet Explorer by clicking the Start button. In the Search box, type
Internet Explorer, and then, in the list of results, click Internet Explorer.

b. Click the Compatibility View button on the Address bar.

Macintosh-based hardware and software
• PowerPC G3 processor or newer (PowerPC G4 preferred)

• Operating system: Mac OS X v10.3

• Browser: Safari 1.3.2

• TCP/IP network connection of at least 56 Kbit/s

• Speakers for playing voice messages on your computer

• A microphone connected to your computer, or a telephone situated near your computer,
for recording voice messages

 Note:
The type of microphone to use depends on the type of Macintosh you have; a microphone
designed for a Windows-based PC does not always work.

Linux-based software
• Red Hat Linux 9

• Browsers: Mozilla 1.7.x, Firefox 2.0 to Firefox 11.0

• TCP/IP network connection of at least 56 Kbit/s

• A microphone connected to your computer, or a telephone situated near your computer,
for recording voice messages

Macintosh-based hardware and software
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Peripheral hardware and software (including audio player)
• Video display and monitor with 8-bit (256-color) 800 x 600 or greater capability (1024 x

768 16-bit color preferred)

• A network connection to the My CallPilot server, and to the CallPilot server where
applicable, for accessing CallPilot messages

• To create faxes:

- For Windows systems, the Avaya Fax Driver and CallPilot desktop messaging.

- For Macintosh and Linux systems, you must provide your own software for creating
faxes.

• To play and record voice messages: CallPilot Player, or another audio player that can
play WAV files.

- For Windows systems: If you are using Internet Explorer, you can use the CallPilot
Player that is conveniently embedded inside the browser to play and record voice
messages. Otherwise, you can use the CallPilot Player as a browser helper
application (stand-alone version of the CallPilot Player). If you choose not to use the
CallPilot Player, you can use the Microsoft Windows Media Player, or another WAV-
compatible media player. These players do not function in exactly the same way as
the CallPilot Player described in this guide.

- For Macintosh and Linux systems, you must provide your own audio player to play
and record voice messages.

Requirements for the embedded CallPilot Player
For Windows systems, My CallPilot includes an embedded audio player that conveniently
appears on the page you use to compose and listen to voice messages, as shown here:

Using My CallPilot
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For the embedded player to automatically appear in My CallPilot, your workstation and My
CallPilot must meet the following requirements:

• your browser must be Internet Explorer

• the CallPilot Player must be installed (for instructions, see To download audio players on
page 16)

• you must have VBK set as your audio type in your My CallPilot preferences (for
instructions, see Setting messaging preferences on page 57)

Logging on
Your administrator provides you with the URL for My CallPilot. Bookmark this address in your
Web browser for easy access.

Logging on
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To log on to My CallPilot
1. In your Web browser, navigate to the My CallPilot address.

Example:

http://serverABC/mycallpilot

2. On the Welcome page, in the Mailbox box, type your mailbox number. This number
is usually your office telephone extension number.

3. In the Password box, type the password for this mailbox.

 Note:
Do not select the Remember Password check box on a shared computer.

If SSL encryption is enabled, the Enable Secure Login link appears.

4. Click Login.

Logging on to environments with multiple CallPilot
servers

If your site has more than one CallPilot server to which you can connect, a Location list
containing multiple CallPilot servers appears in the Welcome page.

Selecting a server from this list lets you select (and log on to) your CallPilot server without
needing to know any of your server-specific settings beyond your mailbox and password.

Using My CallPilot
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To configure or update the settings to connect to My
CallPilot

Under normal circumstances, your CallPilot administrator configures the settings that allow
you to log on to My CallPilot. If this is not the case, you might need to add or update the settings
so that you can log on successfully.

1. In your Web browser, navigate to the My CallPilot address.

2. On the Welcome page, click Configure.

The Configure dialog box appears. The information shown in the following
illustration is an example only.

3. Type or update the configuration information. If you do not have this information,
contact your CallPilot administrator.

4. Click OK.

The system attempts to connect you using the information you entered.

5. If the connection is successful, click OK on the confirmation messages, and then
try logging on again. If the connection is not successful, contact your CallPilot
administrator for assistance.

To change to another server
If you have a mailbox on another CallPilot server, you can log on to that server from My
CallPilot. Click Configure, type the server details, then click OK until you return to the Welcome

To configure or update the settings to connect to My CallPilot
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page. When you log on again from the same computer, CallPilot accesses the new server. To
change back to your default server, click Configure, then click Restore Defaults.

To change to another language
If language buttons are available on your My CallPilot log on page, you can click one to change
from your default language to another language.

To log on using secure login
If the Enable Secure Login link is available on your login page, click it to enable SSL encryption.
The Login Securely button appears. Bookmark the link for future use.

To log on remotely
You can log on to My CallPilot from any computer that has Internet access and supported
browser configuration. You can use the pre-installed audio player for voice messages, or you
can download the CallPilot Player for full feature capability.

To log out
To log out from My CallPilot, click Logout on any My CallPilot page.

To download audio players
You need an audio player to play and record voice messages. If you do not have the CallPilot
Player installed, the first time you log on to My CallPilot, you are prompted to download it.
Follow the instructions to start the download and installation process. If you choose to use a
different audio player, arrange to install it if it is not already installed.

If you choose not to download the player when you first log on, you can do so later on using
the following procedure.

Using My CallPilot
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1. Log on to My CallPilot.

2. Click the CallPilot Features tab, and then click the Downloads item.

3. Select CallPilot Player & MWI icon or another audio player from the list.

4. Follow the instructions to download and install the audio player.

The stand-alone version of the CallPilot Player is shown here:

 Note:
The CallPilot Player software is bundled with software for a Message Waiting Indicator
(MWI). When installed, the Message Waiting Indicator appears as an icon in the Windows
taskbar, and it notifies you when you have new CallPilot messages. For more information,
see Using the Message Waiting Indicator on page 34.

Accessing your CallPilot messages
You can access your CallPilot messages from the CallPilot Messages tab. You can play voice
messages and view faxes, delete, forward, and reply to messages, and compose new
messages.

To check for new messages
To see new messages, click Refresh. New messages appear in bold.

To sort your messages, click on a column heading, for example, Subject or Received.

 Note:
Only the messages currently displayed are sorted, which might not be the entire message
list.

Accessing your CallPilot messages
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To open a message
To open a CallPilot message, click the voice, fax, or text icon in the attachments column beside
the message, or click any underlined part of the message line. See Playing voice
messages on page 20, and Viewing fax messages on page 22.

To select a message
To select a CallPilot message, check the box at the far left of the message line. When a
message is selected, you can delete, forward, or reply to it.

To delete a message
To delete a CallPilot message, select the message and click Delete or Delete Now. If you click
Delete, the message temporarily moves to your Deletable Items folder, and then it is
permanently deleted when you log out. If you click Delete Now, all selected messages, and
items in your Deletable Items folder, are permanently deleted immediately.

If you want to keep items in your Deletable Items folder after you log out, you can change this
setting on the My CallPilot Preferences page. See To change environment settings on
page 58.

 Note:
To view items in your Deletable Items folder, from the CallPilot Messages tab, select
Deletable Items from the Folder list.

To select your telephone or computer to play and record
voice messages

You can choose to play and record voice messages through your telephone or your computer.
Click the telephone or computer icon in the embedded or downloaded CallPilot Player. If you
have any problems using your telephone for this purpose, contact your CallPilot
administrator.

Using My CallPilot
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See Setting messaging preferences on page 57, to change the audio setting and the number
that CallPilot dials for playing and recording messages.

Changing your message sort order
You can change the order your messages play using the Message Sorting Options tool.

Changing Message Sorting Options

1. From My CallPilot, select CallPilot Features, Message Sorting Options.
2. Select whether to Use custom settings or to Use default settings defined by your

administrator.
3. If you select Use custom settings, you can define the Sort order and Entry point for

messages.
4. Click Save.

Table 1: Sort order options

Option Description
Messages are sorted by Sorts messages according to the selected option:

• Priority – Urgent first

• Priority – Standard first

• Status – Unread first

• Status – Read first

• No selection (default)

then by Sorts message by a second condition. The available options are
limited by what has been selected in the Messages are sorted
by list box.
If a Priority based sort key was selected then the available
options are:

• Status – New first

• Status – Read first

• Clear – (No selection)

If a Status based sort key was selected then the available
options are:

• Priority – Urgent first

• Priority – Standard first

• Clear – (No selection)

Changing your message sort order
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Option Description
If Clear was selected then this option is automatically set to
Clear.

Finally by Sorts messages by Delivery Time:

• Oldest first (default)

• Newest first

Table 2: Entry Point options

Option Description
The mailbox entry point is Select the rule for the first message to play when checking

messages:

• First New message (default)

• First New Urgent message

• First Urgent message

• First Unsent message

• Clear (no selection)

Else Select the rule for the first message to play if no message
matching the first mailbox entry point exists:

• First New message (default)

• First New Urgent message

• First Urgent message

• First Unsent message

• Clear (no selection)

Playing voice messages
Before playing voice messages, see To select your telephone or computer to play and record
voice messages on page 18.

Using My CallPilot
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To play a voice message the quick way (Windows only)
Use the embedded CallPilot Player, if available, to play your voice messages quickly. If you
cannot see the embedded player in your message list, see Requirements for the embedded
CallPilot Player on page 12.

1. In your message list, click the voice icon in the attachments column beside the
message you want to play (see the following illustration).

Note that this icon appears as a telephone instead of a black arrow if your audio
format is set to WAV in your My CallPilot preferences.

2. If you are not using the embedded player, follow the prompts to open the audio file.
When the audio player appears, press the play button.

The controls on the embedded CallPilot player are shown here:

If you select the computer for playback, the audio player plays your message from
your computer speakers. If you select the telephone for playback, your telephone
rings and plays the message when you answer.

3. Use the player buttons to stop or replay the message, or to call the sender. You can
use the slider control on the player to skip to another part of the message.

4. If you are using the telephone, when finished, click the disconnect icon or hang up
the telephone.

5. To return to your messages, click Message List.

To play a voice message the quick way (Windows only)
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To play a voice message in a mixed voice, fax, or text
message

CallPilot messages can have more than one type of attachment. In your message list, each
attachment appears as a different icon beside the message in the attachment column.

1. In your message list, click any underlined part of the message to open it.

The mixed message appears with each attachment shown on the left.

2. To play the voice message, click the Voice icon. For more details on playing a voice
message, see the preceding procedure.

Viewing fax messages
To view faxes on your computer you must have appropriate software.

• For Windows systems, you can use the viewer included with the Windows operating
system, or install your own software.

• For Macintosh systems, QuickTime Viewer can display faxes.

• For Linux systems, Eye of GNOME or kfax software can display faxes.

To view a fax message
1. In your message list, click the fax icon in the attachment column beside the fax

message you want to view, or click any underlined part of the message.
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If the Open/Save dialog box appears, select Open to display the image.

2. Use the controls supplied with the fax viewing software to work with the fax.

3. When you finish, close the fax image to return to your messages.

Composing voice messages
If you use Internet Explorer for Windows, you can compose a voice message using one of two
methods:

• You can use the embedded CallPilot Player to record the voice message (VBK format
only) and automatically attach it to the message. If you cannot see the embedded player
when you compose a message, see Requirements for the embedded CallPilot Player on
page 12.

• You can use the stand-alone CallPilot Player to record your message and then save it as
a stand-alone file. You can then attach it to one or more messages and send it.

These procedures are described in the following sections.

If you are using a different browser or player, or if you are using a Macintosh or Linux system,
you must first record the message in your audio player and then attach it to the CallPilot
message before sending it. For information about adding an attachment to a message, see 
Adding attachments to messages on page 30.

 Note:
You cannot add additional audio to audio files that exist in your inbox.

To record and send a new voice message using the
embedded CallPilot Player

1. In your message list, click Compose. A new message page appears.

2. Address the message. For more information, see Addressing messages on
page 31.

3. In the Subject box, type a subject for the message.

4. Choose how you want to record the voice message: in the embedded Windows
CallPilot Player, select either the telephone or the computer icon.

Composing voice messages
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 Note:
If you select the telephone to record the message, ensure you have your
telephone number configured in My CallPilot. To check, click the My CallPilot
Features tab, and then click the My CallPilot Preferences item. In the
Environment Settings, ensure your telephone number is entered in the Number
to call for telset playback (ie. your phone) box.

5. To begin recording your message, click the record button.

6. Do one of the following:

• If you are recording from a computer, speak into the microphone.

• If you are recording from a telephone, answer when the telephone rings. At
the tone, record your message into the handset.

7. When you finish speaking:

• To end the recording, click the stop button.

• To review the recording, click the play button.

• To add to the recording, click the record button, speak again, and then click
the stop button.

8. If you are using the telephone, when finished, click the disconnect icon or hang up
the telephone.
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9. When you are satisfied with the message, click Save Audio. This automatically adds
the recording as an attachment to the message.

10. Click Send.

To record and save a message using the stand-alone
CallPilot Player

To save a copy of your voice recording as a stand-alone file you must use the stand-alone
CallPilot Player, not the embedded CallPilot Player.

1. Open the stand-alone CallPilot Player (from the Windows Start menu, choose
Programs > Avaya > CallPilot Desktop Messaging > Audio Player).

2. Choose how you want to record the voice message: in CallPilot Player, select either
the telephone or the computer icon.

 Note:
If you select the telephone to record the message, ensure you have your
telephone number configured in My CallPilot. To check, click the My CallPilot
Features tab, and then click the My CallPilot Preferences item. In the
Environment Settings, ensure your telephone number is entered in the Number
to call for telset playback (ie. your phone) box.

3. To begin recording your message, click the record button.

4. Do one of the following:

• If you are recording from a computer, speak into the microphone.

• If you are recording from a telephone, answer when the telephone rings. At
the tone, record your message into the handset.

To record and save a message using the stand-alone CallPilot Player
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5. When you finish speaking:

• To end the recording, click the stop button.

• To review the recording, click the play button.

• To add to the recording, click the record button, speak again, and then click
the stop button.

6. If you are using the telephone, when finished, click the disconnect icon or hang up
the telephone.

7. On the CallPilot Player File menu, click Save or Save As.

8. In the File name box, type a name for the file, select a folder to keep the file in, and
then click Save. Save voice files as VBK files.

 Note:
My CallPilot automatically converts VBK files to WAV files when sending to non-
CallPilot users.

9. Add the saved recording as an attachment to one or more CallPilot messages. For
instructions, see Adding attachments to messages on page 30.

Composing fax and text messages
To create a fax file, your CallPilot mailbox must have fax capability, and your computer must
have desktop messaging installed. After you save the fax file, you can add the fax to a message
as an attachment. Your CallPilot recipients must have fax capability to view your fax on their
computer. If your recipients access their messages from their telephone, they can view the fax
only by printing it. You can also send your fax to a fax machine.

For Macintosh and Linux systems, Avaya does not supply software for creating faxes. You
must supply your own software to do this, and then attach the fax message to a CallPilot
message before sending it. The fax file must be TIF-F format. For information about adding an
attachment to a message, see Adding attachments to messages on page 30.

To create and save a fax file
1. Start the application you want to use to compose the fax, for example, Microsoft

Word. The document you open or create must be 8.5 in. (21.5 cm) wide or less.
Multiple page documents are allowed.

2. When the document is ready, from the File menu, click Print or whichever option
opens the dialog box to allow you to select a printer.
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3. From the list of printers, select Avaya Fax.

4. Click OK or Print, or whichever option sends the file to the printer you selected. The
Compose Fax dialog box appears.

5. Click Save As.

6. Type a name for the file.

 Note:
If you chose to include a subject line, the information in that text box is displayed
in the e-mail portion of the fax. The subject line is not displayed on a hard copy
of the fax.

7. Browse to select a folder to save the file in.

8. Ensure the selected file format is TIFF-F (*.tif).

9. To save the file to the folder you specified, click OK.

10. Click Exit.

To compose and send a fax or text message
1. In your message list, click Compose. A new message page appears.

2. Address the message. For more information, see Addressing messages on
page 31.

3. Add a fax file as an attachment as follows:

a. Click Attach Files.

To compose and send a fax or text message
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b. In the File to attach box, click Browse, navigate to and select the file that
you want to attach, and then click Open. Alternatively, you can type the
path and file name in the File to attach box.

c. To attach additional files, repeat the previous step.

d. Click OK. An icon representing each attached file appears beside the
Attach Files button on the message.

4. If you want to include a message with the fax attachments, type the message.

5. Click Send.

Calling the sender of a message
You can respond to a message with a telephone call instead of a recorded message. My
CallPilot includes a Call Sender button that appears in both the message list and when you
are in an open message. Clicking the Call Sender button calls the sender of the currently
selected message, regardless of whether or not the message contains an audio attachment.

To use the Call Sender feature, ensure you have your telephone number configured in My
CallPilot. To check, click the My CallPilot Features tab, and then click the My CallPilot
Preferences item. In the Environment Settings, ensure your telephone number is entered in
the Number to call for telset playback (ie. your phone) box.

If the Call Sender button does not appear, it could be due to the following:

• You are not viewing a message on the CallPilot server (for example, you are viewing a
message on the e-mail tab that is linked to your e-mail inbox).

• The system administrator has not enabled this feature for your mailbox class.
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To call the sender of a message
1. Open the message, or from the message list select the check box to the left of the

message.

2. Click Call Sender.

One of the following dialog boxes appears, depending on whether or not you are
using Internet Explorer and have the CallPilot Player installed.

3. Click either Call or Call Sender.

4. When your telephone rings, answer it and the sender's number is automatically
called.

Forwarding and replying to messages
You can forward a message, and compose an introduction to send with it. You can also
compose a reply to the sender of a message, or to the sender and all recipients of a
message.

To forward or reply to a message
1. In an open message, click Reply, Reply All, or Forward.

To call the sender of a message
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2. On the new message page, compose a voice, fax, or text message.

3. Address forwarded messages the same way as a new message. Replies are
addressed automatically.

4. Add attachments, set options, and change the subject line if required.

5. Click Send.

Adding attachments to messages
Before sending a message, you can attach one or more voice, fax, or text files to it. Voice files
can be either VBK or WAV format. My CallPilot automatically converts VBK files to WAV files
when sending to systems that do not support VBK. Fax files must be TIF format. Text files must
be TXT format.

To attach a file to a message
1. On a new message page, click Attach Files.

2. In the File to attach box, click Browse, navigate to and select the file that you want
to attach, and then click Open. Alternatively, you can type the path and file name
in the File to attach box.

3. To attach additional files, repeat the previous step.
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4. Click OK. An icon representing each attached file appears beside the Attach Files
button on the new message.

5. Continue to compose, address, and send the message as usual.

Setting message options
Before sending a message, you can set options for handling and delivery.

To set message options
1. On a new message page, select Priority, Sensitivity, and read receipt options, as

required.

• For Priority, select Low, High, or leave the setting as Normal.

• For Sensitivity, select Private, or leave the setting as Public.

You cannot forward messages that are marked Private to other CallPilot
addresses. However, be aware that when you send a message marked
Private, your recipient can still forward the message to someone else, if the
recipient does not have a CallPilot address. Also, recipients in non-CallPilot
systems are not informed of Private settings. In your message, tell the recipient
that the message is private.

• For Notify me when message is read, select the check box to request
acknowledgment that your recipient opened the message.

2. Continue to compose, address, and send the message as usual.

Addressing messages
You can address a CallPilot message in two ways:

• You can select a name from the CallPilot Address Book that is maintained by your
organization on the server. The CallPilot Address Book contains the addresses of the
CallPilot users and shared distribution lists that you can use.

• You can manually enter addresses using the Enter a Special Address dialog box.

Setting message options
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Accessing CallPilot addresses from other networked
CallPilot servers

If your site has more than one CallPilot server, your CallPilot administrator can provide you
access to additional CallPilot Address Books on networked servers. In this case, you can
choose which CallPilot Address Book you want to search when addressing a message (see
the Available Address Books list in the following illustration).

Alternatively, your CallPilot administrator can create a central directory of addresses drawn
from multiple CallPilot servers. In this case, you do not have to choose the address book to
search, but you automatically have access to an expanded list of CallPilot addresses to search
when addressing a message.

If you do not need access to CallPilot addresses on other networked servers, you can configure
your CallPilot Address Book to include only addresses from your local server using a check
box on the My CallPilot Preferences page. For more information, see To change environment
settings on page 58.

To address a message from the CallPilot Address Book
1. In a new CallPilot message, click To (or Address Book).

The Select recipients from the Address Book dialog box appears.
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2. If the Available Address Books list appears, you must choose which CallPilot
server's Address Book or directory you want to search to address the message. The
system administrator determines what you see in this list.

3. In the Enter Last Name (or *) box, do one of the following:

• To look up a single address, type the recipient's last name (or just the first letter
or first few letters), and then click Find.

• To get a list of all entries in the Address Book, type an asterisk (*), and then click
Find.

4. In the list of names, select the name of the recipient or distribution list, and then
click To.

5. You can look up additional names as required. To add more names, select the
name, and then click either To, Cc, or Bcc. (Bcc stands for blind carbon copy; the
recipient gets a copy of the message, but the recipient's name is not visible to other
recipients of the message.

6. To return to the new CallPilot message, click OK.

To address a message in Special Addresses
1. In a new CallPilot message, click Special Addresses.

The Enter a Special Address dialog box appears.

To address a message in Special Addresses
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2. Select an address format from the drop-down list (for example: Network mailbox or
Personal Distribution List). Note that Personal Distribution List entries appear
alphabetically sorted when doing an Address Book search.

3. Type the number and any other information required. Refer to the online Help for
the correct addressing formats.

4. Click either To, Cc, or Bcc.

Using the Message Waiting Indicator
My CallPilot includes a Message Waiting Indicator (MWI) that appears as a telephone handset
icon in the lower-right corner of your screen, in the Windows taskbar or system tray. The
Message Waiting Indicator notifies you if you have new messages and provides you with quick
access to your inbox.

A red telephone handset icon indicates that you have new messages:

The appearance of the Message Waiting Indicator icon changes to give you additional
information about your connection to the server as follows:
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 Note:
When using a Geographic Redundant pair of servers, your server information is visible by
holding your mouse over the Message Waiting Indicator icon. This tells you if you are
connected to the main or alternative server, and provides the IP address of the current
server.

To download and install the Message Waiting Indicator
If you have desktop messaging installed on your workstation, or if you have already
downloaded the stand-alone CallPilot Player, you should already see the Message Waiting
Indicator in your taskbar. If you do not, you can download and install it as follows:

1. In My CallPilot, click the CallPilot Features tab.

2. Click the Downloads item.

3. Click CallPilot Player & MWI icon, and then follow the instructions to save and install
the player and Message Waiting Indicator.

To configure the Message Waiting Indicator
Use the CallPilot MWI Configuration dialog box to

• show or hide the Message Waiting Indicator

• enable and disable its pop-up balloon text

• control how long the balloon text stays on the screen

1. In the Windows taskbar, right-click the Message Waiting Indicator icon.

2. Click CallPilot MWI Configuration.

To download and install the Message Waiting Indicator
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 Note:
The first four boxes (Server, Alternative Server, VPIM network shortcut, and
Mailbox) are for information only and they appear dimmed; if you want to change
information in these boxes, you can access them on the General tab at Tools >
CallPilot Desktop Messaging > Configuration.

 Note:
The green circle containing a check mark indicates which server is currently
active. If neither server is available, then the minus sign appears next to each
server. The client  automatically restores connection to the appropriate server
when connectivity becomes available.
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 Note:
If an alternative server is configured while you are logged in to CallPilot, your
alternative server information will only be visible after you have logged out and
logged in again.

3. If you want to be able to open My CallPilot by double-clicking the icon, ensure that
the My CallPilot URL box contains the correct URL.

Ask your CallPilot administrator for the correct URL. Typically, the URL appears in
one of these formats:

http://prefix.hostname.com/mycallpilot/

http://IP address/mycallpilot/

4. To show or hide the icon, select or clear the Show MWI Icon on taskbar check
box.

 Note:
If you hide the icon and then decide you want to show it again, from the Windows
Start menu, choose Programs > Avaya > CallPilot MWI Icon. It reappears in the
taskbar.

5. To enable or disable the balloon text, select or clear the Display pop-up balloon for
x seconds check box. You can also change the number of seconds.

6. To save your changes, click OK.

To use the Message Waiting Indicator
Here are some helpful tips for using the Message Waiting Indicator.

• To open your latest CallPilot message, double-click the Message Waiting Indicator
icon.

 Note:
If this does not work, ensure that the My CallPilot URL box contains the correct URL
in the CallPilot MWI Configuration dialog box. To open it, right-click the Message
Waiting Indicator icon, and then click CallPilot MWI Configuration.

• To display your mailbox number, the address of the server, and the number of messages
waiting in your inbox, move your pointer over the icon.

• Right-click the icon to display a shortcut menu with options to:

- open My CallPilot (if a URL for My CallPilot is defined in the configuration settings
for the Message Waiting Indicator)

To use the Message Waiting Indicator
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- configure the Message Waiting Indicator

- log on to or off from your CallPilot mailbox

- exit from the Message Waiting Indicator so it no longer appears

CallPilot Features tab
Click the CallPilot Features tab to change the settings for your CallPilot features and telephone
options, and to set preferences for Web-based access.

The main CallPilot Features page displays only the features that are available for you to use.
Click any item to open its settings page.

Working with greetings
Using My CallPilot, you can record and manage your voice greetings and personal
verification.

If you use Internet Explorer on a Windows system, you can use the CallPilot Player to record
and play greetings or personal verification from My CallPilot. Alternatively, you can import WAV
files recorded on other audio devices for greetings and personal verification messages.

You can record external, internal, and temporary greetings. Callers from outside your
organization hear your external greeting, and callers within your organization hear your internal
greeting. If you do not record an internal greeting, all callers hear your external greeting. If you
record a temporary greeting, it is played to all callers in place of your external and internal
greetings until it expires or you delete it.

To access greetings
• Click the CallPilot Features tab, and then click the Greetings item.
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The Greetings page appears.

To record or change a greeting using your telephone
Ensure you have your telephone number configured in My CallPilot.

• To check, click the My CallPilot Features tab, and then click the My CallPilot Preferences
item. In the Environment Settings, ensure your telephone number is entered in the Number
to call for telset playback (ie. your phone) box.

 Note:
If you want to record greetings using the stand-alone CallPilot Player or another audio device
instead of the telephone, see Importing a greeting recorded with a stand-alone audio
device on page 39.

1. Click the CallPilot Features tab, and then click the Greetings item.

2. To start recording, click the Edit icon beside the greeting type.

3. When your telephone rings, answer it. At the tone, record your message into the
handset.

4. When you finish speaking:

• To end the recording, click the stop button.

• To review the recording, click the play button.

5. When you are satisfied with the greeting, click Save Greeting.

6. When you are finished, click the disconnect icon or hang up the telephone.

7. If you recorded a temporary greeting and you want to revert back to your regular
greeting by a certain date and time, under Expiry date, click the date option, and
then select a date and time.

Importing a greeting recorded with a stand-alone audio
device

You can record and then import a new or changed greeting using the stand-alone CallPilot
Player or any other audio device that supports WAV format.

1. Open your audio device and record a voice greeting or personal verification.

To record or change a greeting using your telephone
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To open the stand-alone CallPilot Player, from the Windows Start menu, choose
Programs > Avaya > CallPilot Desktop Messaging > Audio Player.

2. Save the recording. For the CallPilot Player, save in VBK format. For other audio
devices, save in WAV format.

3. Click the CallPilot Features tab, and then click the Greetings item.

4. Click the Import icon beside the greeting type.

5. Click Browse, select the audio file, and then click Open.

6. Click Save.

7. If you recorded a temporary greeting and you want to revert back to your regular
greeting by a certain date and time, under Expiry date, click the date option, and
then select a date and time.

8. Click OK.

To delete greetings
1. Click the CallPilot Features tab, and then click the Greetings item.

2. Click the Delete icon beside the greeting.

3. Click OK.

Setting up message notification
CallPilot can notify you of new messages when you are away from the office. Your administrator
defines whether these devices and services are available to you:

• Remote Text Notification to a wireless e-mail device. See Remote Text Notification for
Microsoft Outlook and BlackBerry Devices on page 63.

• Remote Notification to a telephone or pager. This type of remote notification can be set
up and turned on or off from your telephone as well. You can set up two time periods for
notification, and choose whether you want to be notified of all messages or urgent
messages only.

You can have the two types of notification turned on simultaneously.
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To access message notification options
• Click the CallPilot Features tab, and then click the Message Notification item. The Message

Notification page appears.

To access message notification options
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Setting up message forwarding
You can forward your CallPilot messages to a CallPilot mailbox or to an external e-mail
address. To do this you must create a message forwarding rule, which is a set of criteria
defining which messages to forward and where to forward them.

When you enable a message forwarding rule, you can then access all incoming messages that
meet the criteria from another location, such as an Internet mailbox or a Personal Digital
Assistant (PDA). You can enable and disable message forwarding as required. Voice
messages can be forwarded in the format in which they are received or converted to WAV.

In My CallPilot, you can set up your own message forwarding rule using the following
procedures, or you can have the CallPilot administrator set it up for you. For security reasons,
you must enable it yourself.

To set up message forwarding
1. Click the CallPilot Features tab, and then click the Message Forwarding Rule

item.

2. Click Configure Rule.

The Configure New Message Forwarding Rule page appears.

Setting up message forwarding
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3. From the Messages to forward list, select the type of messages you want to
forward.

4. From the Forward to options, select either E-mail address or CallPilot address. Note
that each rule can include only one address.

5. Do one of the following:

• If you chose E-mail address, type the address in the adjacent box.

Example: john.smith@acme.com

 Note:
You can also type an e-mail distribution list.

• If you chose CallPilot address, you can either:

- Click the CallPilot link to open the Select Recipient dialog box, and then
select or type a CallPilot address or an Open VPIM address. Then click
OK.

- Manually type a CallPilot mailbox or Open VPIM address. Note that
CallPilot distribution lists, telephone numbers, and fax addresses are not
accepted. Use the following address formats:

Local mailbox:
<local VPIM prefix><mailbox>@<local FQDN>
Remote mailbox:
<remote location VPIM prefix><mailbox>@<local FQDN>
Open VPIM:
VPIM=<VPIM shortcut><mailbox>/<remote FQDN>@<local FQDN>

6. If you want the original CallPilot message to appear as read (for example, not bold)
in your mailbox under certain circumstances (see the next step), select the Mark
original message as read check box.

7. If you checked the Mark original message as read check box, select one of the
following options:

• Forwarded by this service: As soon as a message is automatically forwarded,
it appears as read in your CallPilot inbox.

• Opened by the recipient: The message appears as read in your CallPilot inbox
only after it is opened in the location to which it is forwarded. This option works
only if the e-mail server to which the message is forwarded supports read
receipt capability. This option is not supported if you forward messages to a
CallPilot address.

For this option, you can also select Then automatically delete original
message. This way, only the forwarded copy of the message is kept and you
have only one copy to keep track of. Note that this option is not available if
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Forwarded by this service is selected, because there is no guarantee the
message will ever be received by the remote e-mail server.

8. If you want to convert outgoing voice messages to WAV format, select the WAV
option. You might want to do this if the CallPilot Player is not available to play VBK
messages at the forwarding address.

You can chose a codec type for a forwarded voice message being converted to
WAV format.

For 600r/1005r/1006r CallPilot server platforms PCM, G711, ADPCM and GSM
6.10 WAV formats are allowed. For other servers PCM and G711 WAV formats are
allowed.

9. To create this rule, click Save. Note that the rule is automatically enabled. To disable
it until you are ready to use it, clear the Enable check box.

10. Click OK.

To enable or disable message forwarding
1. Click the CallPilot Features tab, and then click the Message Forwarding Rule item.

The Message Forwarding Rule page appears.

2. In the Enable column, select or clear the check box.

3. Click OK.

Managing personal distribution lists
A distribution list saves you time when you send messages to the same group of addresses.
You can create up to 99 personal distribution lists, and enter a number and name to identify
each list. Each personal distribution list can contain up to 200 entries.

To enable or disable message forwarding

Avaya CallPilot® Desktop Messaging User Guide for My CallPilot May 2013     45



A personal distribution list can contain any addresses to which you can send a message,
except other personal distribution lists. An entry can be a mailbox number, shared distribution
list number, network mailbox, open network mailbox, or telephone number.

You can create personal distribution lists in My CallPilot or on your telephone. These lists are
stored for you in the CallPilot Address Book on the CallPilot server. You can access these lists
from My CallPilot, Desktop Messaging, and your telephone.

To edit, delete, or create personal distribution lists
To edit or delete an existing list, select the list and click Edit or Delete. Make the changes, then
click Save.

To create a personal distribution list, click Add New List. Type a number and name for the list.
Add entries by selecting an address format from the drop-down list, then enter the information
required. Refer to the online Help for the correct addressing formats, if required. Click Save.

Changing your CallPilot password

 Note:
You can change a forgotten mailbox password by e-mail or secret question. Contact your
administrator for the required link. See Password change service on page 47.

Your CallPilot password is the same password that you use to log on to CallPilot from the
telephone. CallPilot requires that you change your password on a regular schedule set by your
administrator.

CallPilot prevents you from using some passwords if they are too short or too simple, or if you
have used the same one recently. Keep your mailbox secure by choosing passwords that are
not easily discovered.

To change your password, type your old password, type your new password twice, then click
Save.
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Password change service
The password change service is available for changing your password or changing forgotten
passwords.

Connecting to the password change service web page

1. Access the Password Change Service home page using the link provided by your
administrator.(https://<Web server host name or IP address>/cppwdchange/
default.asp).

2. Select a CallPilot server name from the predefined list and enter your mailbox
number.

3. Click Next. The Password Change Service home page appears.

Modifying password change service settings

1. From the Password Change Service home page, select Modify Password Settings.
The Password Change Service login page appears.

2. Enter your mailbox password and click Login. The Password Change Service page
appears.

From the Password Change Service you can perform the following actions:

Field Description
Change Password Use this section to immediately change your

password. See Changing a password on
page 47.

Email Enter the E-mail address you want Password
Change Service to use when sending
change password E-mails.
Click Save Email settings to save your E-mail
address.

Questions and Answers Enter your secret questions and associated
answers. These questions must be
answered when changing your password
using the Secret Question feature.
Click Save Q & A Settings to save your
questions and answers.

Changing a password

1. From the Password Change Service page, enter a New Password and Confirm New
Password.

2. Click Change Password.

Password change service
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Changing a password by email
This procedure is only available if the Change Password Via Email function has been enabled
by your administrator. Use this procedure if you have forgotten your password.

1. Access the Password Change Service home page.
2. Click Change Password Via Email. A message appears informing you that an email

has been sent to your assigned E-mail address. The link within the E-mail will remain
valid for one hour.

3. Click Close.
4. When you receive the E-mail, click the link provided in the body of the E-mail. The

Mailbox Password Change page opens.
5. Enter a New Password and Confirm New Password.
6. Click Save. Your password has been changed.

Changing a password by secret question
This procedure is only available if the Change Password Via Secret Questions function has
been enabled by your administrator. Use this procedure if you have forgotten your
password.

1. Access the Password Change Service home page.
2. Click Change Password Via Secret Questions. A page opens showing your

previously defined questions.
3. Answer both questions and enter a New Password and Confirm New Password.
4. Click Save. If both answers are correct, a pop-up message informs you that your

password has been successfully changed.

Changing your telephone options
You can modify any of the telephone options described in the following procedures.

To access your telephone options
• Click the CallPilot Features tab, and then click the Telephone Options item.

To assign a custom operator number for callers
You can offer your callers the option of leaving a message or speaking to one of your assistants
or colleagues. In your greeting, tell callers to press zero if they want to speak to this person in
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your absence. The custom operator number is the number your callers reach when they press
zero.

1. In the Custom Operator Number box, type the number .

2. Click Save.

To set times and options for blocking messages from
callers

You can temporarily prevent your callers from leaving messages in your mailbox. You can
choose to transfer callers to your custom operator or disconnect them. As a courtesy to your
callers while message blocking is turned on, record a temporary greeting that provides details
of your absence and tells callers what to do. The message blocking option also prevents My
CallPilot and Desktop Messaging users from sending messages to you.

1. In the Block callers from leaving messages list, specify when to block message
reception:

• Never: Allow callers to leave messages.

• Always: Do not allow callers to leave messages.

• Only when temporary greeting recorded: Do not allow callers to leave
messages when the temporary greeting is recorded.

2. For Blocked callers will be played the greeting, then, choose one of the following
options:

• Transferred to custom operator: When message reception is blocked, play the
mailbox greeting and then transfer the caller to the number specified in the
Customer Operator Number box.

• Disconnected: When message reception is blocked, play the mailbox greeting
and then disconnect the call.

3. Click Save.

To turn Auto Login on or off
When Auto Login is turned on, you do not have to enter your mailbox and password when you
log on from a defined number. Your administrator defines secure numbers for Auto Login, such
as your office or home telephone. When Auto Login is turned on, you access your mailbox by
dialing the CallPilot access number or pressing the message key at one of your defined Auto
Login numbers.

To set times and options for blocking messages from callers
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1. To enable Auto Login, select the Turn on Auto Login for allowed numbers check
box.

2. Click Save.

3. Use your telephone to complete activation of Auto Logon. Log on to your mailbox
from the telephone, and then enable Auto Logon by pressing 804.

To hide your name and number in CallPilot Address Books
You can keep your personal information from being listed in any CallPilot Address Book or the
address book of any desktop client, and ensure that your mailbox is not name dialable or name
addressable from the telephone.

Even with this setting turned on, your name and address

• still appears in any messages you send

• still appears in any messages you receive and is therefore viewable by others on the
distribution list for that message

1. Select the Hide my name and number in all CallPilot address books, including Name
Dial check box.

2. Click Save.

To select which directory numbers are associated to your
Message Waiting Indicator

Message Waiting Indicator Directory Numbers (MWI DN) are assigned by the administrator.
You cannot change the numbers; however, you can see these MWI DNs in your telephone
options and identify which ones to associate to your Message Waiting Indicator.

1. In the Message Waiting Indicator at telephone section, select the check box beside
each DN that you want associated with your Message Waiting Indicator.

2. Click Save.

Setting up telephone access to e-mail
If you have a linked e-mail account set up, you can configure it for telephone access. You can
check for new e-mail messages while logged in to CallPilot from your telephone. You can have
the text content of any new e-mail messages read to you over the telephone. If you have not
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yet set up access to your e-mail accounts from CallPilot, see Setting up links to your e-mail
accounts on page 53.

To set up an e-mail account for telephone access
1. Click the CallPilot Features tab, and then click the E-mail By Phone item. The E-

mail By Phone page appears, listing any mailbox links you currently have set up.

 Note:
If you need to set up or edit a mailbox link first, click Configure New Mailbox Link.
See To set up a link to your e-mail account on page 53.

2. From the Use voice of list, select a female or male voice to read your e-mail.

3. In the Enable column, select one e-mail account for access by telephone.

4. Click OK.

You can now access your e-mail by logging on to your CallPilot messages using
the telephone and then switching to your e-mail message list by pressing 8-9.

Changing fax printing options
If your CallPilot mailbox has fax messaging capability, you can receive a fax message in your
mailbox and print the fax at a selected fax number. Set options for default fax number, Auto
printing, and print cover page on the Fax Printing page.

To set up an e-mail account for telephone access
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To access fax printing options
• Click the CallPilot Features tab, and then click the Fax Printing item.

To change the default printer
You must set a default fax number. If you are not using Auto printing, a default fax number is
the simplest way to print. The default number can be any fax number that CallPilot can dial,
including any normally required prefixes.

To turn Auto printing on or off
When Auto printing is turned on, any faxes that arrive at your mailbox are automatically printed
at a specified default fax number. A message that has been auto printed remains in your
mailbox so that you can reprint the message or forward the message. Your printed faxes can
be deleted automatically from your mailbox on a schedule set by your administrator.

Auto printing is the most convenient way to handle fax messages while you are in one location.
If you are away from your office, you can turn Auto printing off and print your faxes at another
fax number.

To turn first page printing only on or off
When Print first page only is turned on, automatically printing of faxes that arrive at your mailbox
is limited to the cover page. Print first page only is the most convenient way to economize your
paper.

To turn fax separator page printing on or off
You can select whether to print a fax separator page when you print a fax message. A separator
page identifies you and gives details of the print job, such as the number of pages. Separator
pages are useful if you receive faxes without cover pages. If the sender of the fax includes a
header page with the fax, the header page also prints.
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Setting up links to your e-mail accounts
You can set up links in My CallPilot so that you can check your e-mail for new messages. You
can also forward and reply to messages, and send new e-mails.

You can define up to five e-mail accounts. One of these accounts can be set up for access
from your telephone. See Setting up telephone access to e-mail on page 50.

To set up a link to your e-mail account
My CallPilot supports various settings when configuring an external e-mail server. Some of
these settings are configured in CallPilot Manager, while others are specified in My CallPilot.
This way, My CallPilot can work correctly in situations where your corporate IMAP, SMTP and
LDAP servers are on different hosts.

Consult your administrator if you are required to enter or change these settings and are
uncertain of the appropriate entries.

 Note:
In the following procedure, the check boxes for This server requires a secure connection
will appear automatically selected and dimmed if the CallPilot administrator has specified
that only SSL connections can be used.

1. Click the CallPilot Features tab, and then click the Mailbox Links item.

2. Click Configure New Mailbox Link. The Configure New Mailbox Link page
appears.

Setting up links to your e-mail accounts
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3. Select your e-mail server from the Mailbox server drop-down list. Your CallPilot
administrator creates this list.

4. Type a name for this account to display on the tab.

5. Type the name of the folder to access for your e-mail messages, such as INBOX.

6. Type your e-mail address.

7. Type your mailbox user name (the user ID of your e-mail account).

8. Type the password for this e-mail account.

9. Retype the password for this e-mail account to verify it.

10. If the mail server for this e-mail account requires a secure connection, click This
server requires a secure connection.

11. In the Outgoing mail server (SMTP) settings, complete the following steps if the
SMTP server requires authentication:

a. Select the This server requires a user name and password check box.

b. Type your mailbox user name (the User ID of your e-mail account).

c. Type the password for this e-mail account.

d. Retype the password for this e-mail account to verify it.
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12. In the Directory service (LDAP) section, complete the following steps if the LDAP
server requires authentication:

a. Select the This server requires a user name and password check box.

b. Type your mailbox user name (the User ID of your e-mail account).

c. Type the password for this e-mail account.

d. Type the password again to verify it.

13. Click Save.

14. On the Mailbox Links page, click OK. A new tab appears in My CallPilot with a link
to the e-mail account you just configured.

These settings allow My CallPilot to be configured easily to work in nearly any corporate e-
mail environment.

 Note:
To log on anonymously, clear This server requires a user name and password, for both
SMTP and IMAP. Note that some servers require authentication and do not allow logging
on anonymously.

Searching external e-mail address books (LDAP
databases)

You might have access to an external address book if there is one defined for your e-mail
server and it is configured by your administrator in CallPilot Manager. In the preceding
procedure, completing the fields in the Directory Service (LDAP) section allows you to search
external LDAP databases if the LDAP server requires authentication. This means you can
search the external address book when composing a new external e-mail server message,
just as you do when composing a CallPilot message. Note that you do not have the ability to
specify the port numbers; these are defined by the administrator in CallPilot Manager.

 Note:
The administrator must enter the correct search base, host/IP and port number for the
external LDAP server in CallPilot Manager when the external e-mail server is defined.

When you address a message, the address book that appears depends on the inbox you are
working from. For example, when you compose a new CallPilot message, the address book
displays addresses only from the CallPilot server. When you compose a new Exchange
message, the address book displays addresses only from the Exchange server, and so on.

Distribution lists may appear in the results.

Searching external e-mail address books (LDAP databases)
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Using your linked e-mail accounts
When you have completed configuring your linked e-mail accounts, you can check your e-mail
messages. You can also forward and reply to messages, and send new e-mails.

You can also set up access to a second CallPilot mailbox, which can be on another server.
For setup details, refer to the online Help.

For each linked e-mail account, a tab appears in your My CallPilot session. Your linked e-mail
accounts look similar to your message list on the CallPilot Messages tab, and they work in a
similar way.

To open a message
To open an e-mail message in My CallPilot, click the icon in the Attachments column beside
the message, or click any underlined part of the message line.

To delete a message
To mark an e-mail message for deletion, select the message and click Delete. To ensure that
deleted messages are permanently deleted, open the My CallPilot Preferences page, and in
Environment Settings, check the Remove Deletable items on logout check box.

To compose and send a new message
To compose a new e-mail message, click Compose, type the message, and send the message
the same way as a CallPilot message. The Address Book is not available.

To forward and reply to messages
You can forward and reply to e-mails in the same way as CallPilot messages. You might have
access to an external address book if there is one defined for your e-mail server and it is
configured by your administrator in CallPilot Manager.
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Setting messaging preferences
You can set preferences for your message list displays and behavior, options for message
editing, and your default audio format for voice messaging.

To access messaging preferences
• Click the CallPilot Features tab, and then click the My CallPilot Preferences item.

To change message list columns
You can change the columns in your message list. The Attachments option must be in the
Displayed Columns list to see the embedded player (Windows only) in your message list.

Setting messaging preferences
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To add a signature
Type or paste your signature and other information, and then select the check box if you want
this signature added automatically to outgoing text messages.

To change environment settings
Change any of these My CallPilot settings to your preferences.

 Note:
The Remove Deletable items on logout check box applies to both CallPilot and regular e-
mail messages, as well as messages you access when using E-mail-by-Phone.

Choosing a home page for My CallPilot
Choose the page that you want to display automatically when you log on to My CallPilot.
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Useful Information tab
Click the Useful Information tab to:

• View status and details about your mailbox.

• View online user guides.

• Print online user guide files on your laser printer.

Useful Information tab
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Transcribing voice forms
You can use My CallPilot to transcribe voice forms, if your system administrator has granted
you this capability. If so, your My CallPilot session includes a tab called Voice Forms
Transcription.

A voice form is an electronic equivalent of a paper form or questionnaire. Voice forms can be
used for services such as credit card applications, registration forms, and customer complaints.
Using My CallPilot, you can retrieve and play back the responses left by callers to a voice
form.

For detailed procedures for using My CallPilot to transcribe voice forms, see Voice Forms
Transcriber User Guide (NN44200-110), or refer to the My CallPilot online Help.

Protecting the security of your mailbox
Because My CallPilot is a Web-based product, it is important to take precautions to protect the
security of your mailbox.

• If your administrator has enabled SSL encryption, you can use the Secure Login feature
for greater security. See To log on using secure login on page 16.

• When you finish using My CallPilot, make sure that you log out. If you go to a Web site
outside of My CallPilot without logging out, you remain logged in until your My CallPilot
session times out. This can make your CallPilot information vulnerable to hackers. If you
want to visit a Web site without exiting My CallPilot, use a separate browser window to
view the other site.

• You can set CallPilot to log out automatically after a short time, such as 5 or 10 minutes.
See Setting messaging preferences on page 57.

• If you use a public or shared workstation, avoid using the Remember Password option
when you log on to My CallPilot. If this option is selected, others can access your CallPilot
mailbox.

• If you use a public or shared workstation, empty the browser cache after a CallPilot
session. For information about your browser cache, see your browser online Help.

Transcribing voice forms
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Remote Text Notification for Microsoft
Outlook and BlackBerry Devices

Remote text notification can be configured to send a message to your SMTP e-mail account
when a new voice, fax, or text message arrives in your Avaya CallPilot® mailbox. You can set
up notification to any e-mail server that supports SMTP. These include most e-mail accounts,
wireless handheld organizers, mobile phones, or PDAs like the Research In Motion
BlackBerry.

To set up My Avaya CallPilot for remote telephone or pager notification, see Setting up
message notification on page 40. If you want to forward the actual messages to a PDA that
supports e-mail, you or your administrator can configure a message forwarding rule to do this.
See Setting up message forwarding on page 43.

This section describes how to set up remote text notification for Microsoft Outlook and
BlackBerry devices. Any device or portal with a service provider that supports SMTP can
receive e-mail notification messages. If you plan to use another type of device to receive
remote text notification, ask your CallPilot administrator about any additional setup that is
required for your device.

To receive notification messages on a Research In Motion (RIM) BlackBerry Internet Edition
device, you must configure Microsoft Outlook and BlackBerry Desktop Manager (version 2 or
later) to forward CallPilot notification messages to your BlackBerry device.

If you use a BlackBerry Enterprise Edition device, your administrator can set up notification
message forwarding for you on the e-mail server or configure BlackBerry Desktop Manager to
redirect CallPilot notification messages.

 Note:
If you set up My CallPilot to send CallPilot notification to your Outlook Inbox, and set up
BlackBerry Desktop Manager to send all incoming messages to your BlackBerry device,
your CallPilot notification messages appear in your list of e-mails on your BlackBerry device
with no additional configuration required.
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Notification message format
An e-mail notification message can show the:

• type of message

• name of the person who left the message, if available

• telephone number, if available

For example, John Smith calls from extension 1234 and leaves a voice message for Andrew
Jones. An e-mail message is sent to Andrew Jones with the following text:

You have a voice message from John Smith [1234]

Microsoft Outlook forwards this e-mail message to Andrew's BlackBerry device. The message
appears with the subject CallPilot Notification. When Andrew receives the message, he can
decide whether to retrieve the message from CallPilot or to call John immediately, using a
telephone.

Notification message text for remote text notification can be specified by the administrator or
maibox user. This text will be placed in the subject of the notification message. If notification
message text is not specified system default notification message will be sent to e-mail.

Getting started with remote text notification

Requirements
• You need a BlackBerry device. Ensure that e-mail service on your BlackBerry device is

working.

• Microsoft Outlook must be installed. Currently, BlackBerry Desktop Manager works only
with Microsoft Outlook. Consult your BlackBerry documentation for information about
other e-mail clients.

• BlackBerry Desktop Manager 2 or later must be installed and running on your
computer.

• Remote text notification capability must be enabled and set up for your mailbox by your
CallPilot administrator.

• Remote text notification must be configured and enabled in My CallPilot. For more
information, see Setting up message notification on page 40.
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Configuration steps
Complete the following steps to effectively manage e-mail notification messages.

Step Reference
Create a holding folder for your e-mail notification
messages so that they are stored separately from your
other messages.
If you want to forward all messages in your Outlook
inbox to your BlackBerry device, you can skip this
step.

Creating a notification holding
folder on page 65

Configure BlackBerry Desktop Manager to forward
messages to your BlackBerry device.

Configuring BlackBerry Desktop
Manager on page 68

If desired, configure Outlook to delete old CallPilot
notification messages automatically from the holding
folder.
Alternatively, you can manually delete notification
messages from the holding folder.

Automatically removing notification
messages on page 69

Creating a notification holding folder
You can create a holding folder for your CallPilot e-mail notification messages so that they are
stored separately from your other messages. To store messages in the folder, follow these
steps:

1. Create an Outlook folder for the notification messages.

2. Configure Outlook to route CallPilot notification e-mail messages to the folder using
the Rules Wizard.

To create a notification folder
1. Start Outlook.

2. In the Folder List, select Outlook Today.

Configuration steps
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3. From the File menu, choose New > Folder. The Create New Folder dialog box
appears.

4. In the Name box, type CallPilot Notification, and then click OK. The CallPilot
Notification folder appears in the Folder List.

To route notification messages to the holding folder
1. Choose Tools > Rules Wizard. The Rules Wizard dialog box appears.

2. Click New. The first panel of the Rules Wizard appears.

3. In the list of rule types, select Check messages when they arrive, and then click
Next.

4. In the list of rule conditions, check With Specific words in the subject box.

5. In the Rule description box, click Specific Words. The Search Text dialog box
appears.
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6. In the Add new box, type CallPilot Notification.

7. Click Add. The text "CallPilot Notification" is added to the Search list box.

8. Click OK. The search text "CallPilot Notification" appears in the rule description.

9. Click Next.

10. In the list of actions, check the move it to the specified folder box.

11. In the Rule description box, click Specified. A list of Outlook folders appears.

12. In the folder list, choose CallPilot Notification, and then click OK. The folder name
appears in the rule description.

13. Click Finish. The finished rule is shown in the following illustration:

To route notification messages to the holding folder
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14. Click OK to close the Rules Wizard.

Configuring BlackBerry Desktop Manager
This section explains how to configure BlackBerry Desktop Manager to redirect your e-mail
notification messages.

If you did not create a holding folder for notification messages, and if you already configured
BlackBerry Desktop Manager to forward messages in your Outlook inbox, you can skip this
section.

To configure e-mail redirection
1. From the Windows Start menu, choose Programs > BlackBerry > Desktop Manager.

BlackBerry Desktop Manager appears.

2. In the application list, double-click Redirector Settings. The Redirector Settings
dialog box appears.

3. Click the Advanced tab.
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4. In the Folder redirection section, choose Selected folders.

5. Click Choose Folders.The Choose Folders dialog box appears.

6. Select the folders where you receive messages that you want to redirect to your
BlackBerry device.

• To redirect messages in your holding folder, select the CallPilot Notification
folder.

• To redirect all messages in your Outlook inbox, select the Inbox folder.

7. Click Save to save your folder selection.

8. Click OK to save your redirection options.

9. Exit BlackBerry Desktop Manager.

Automatically removing notification messages
This section explains how to configure Outlook to remove messages automatically from the
CallPilot Notifications holding folder using the AutoArchive feature. If you do not want Outlook
to delete notification messages automatically, you can manually delete them from the folder.

Automatically removing notification messages
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 Important:
If you currently do not use AutoArchive, ensure that you become familiar with this feature
before you activate it. You can have existing folders with AutoArchive settings that have
never been activated. If you activate AutoArchive to delete messages automatically from
the CallPilot Notifications folder, you might find that messages in other folders are being
archived as well.

If you are unsure about what to do, check with your local Microsoft Outlook support group.

You must perform two steps to configure automatic deletion of notification messages:

1. Set up AutoArchive to delete messages from the CallPilot Notifications folder.

2. Activate the AutoArchive feature.

To set up deletion of notification messages
1. In the Outlook Folder List, right-click the CallPilot Notifications folder, and then

choose Properties. The CallPilot Notification Properties dialog box appears.

2. Click the AutoArchive tab.
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3. Select the Clean out items older than check box.

4. Set the time to 1 day.

5. Select Permanently delete old items.

6. Click OK.

To activate AutoArchive
1. In Outlook, choose Tools > Options.

2. Click the Other tab.

3. Click AutoArchive. The AutoArchive dialog box appears.

4. Check the AutoArchive every box and set the frequency to 1 day.

5. Click OK to close the dialog box.

6. Click OK to close the Options dialog box.

To activate AutoArchive
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